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About This Document 

This document describes how to transfer data between the ID scanner and a 
PC.  The ID Scanners come preloaded with software and therefore it is NOT 
necessary to install software on the PC to operate the ID Scanners.  Software 
must be installed to download the transactions and/or use the VIP/Banned list 
(CardVisor III & IV customers)   
 

• The Green Handspring CD installs the Palm Desktop software on a PC 
which is used to transfer data to the ID Scanner 

• The White CardVisor CD contains user documentation and utilities used 
to create the VIP/Banned lists.  See the VIP/Banned section (Cardvisor III 
& IV customers) for install directions. 

 
This document should be used in conjunction with the Handspring Visor user 
manual (on the Green Handspring CD or available on-line at Handspring.com) 
and the CardVisor Hardware User Manual. 
 

Copyright  

Copyright 2002 -> 2005 TokenWorks, Inc.                  Printed in the USA 
www.TokenWorks.com (Company Web Site) 
www.CardVisor.com (Product Web site) 
support@tokenworks.com 
Information in this document is subject to change without notice. No part of 
this document may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, for any purpose, without the express written 
permission of TokenWorks, Inc.  TokenWorks, CardVisor and CardTool are 
trademarks of TokenWorks, Inc. Visor and Handspring are trademarks of 
Handspring Inc. 
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 Downloading Data from the ID Scanner to a PC 

Installing PC Software 

  The Palm Desktop Application is on the Green Handspring CD and is 
used to transfer data between the PC and the Handspring Visor handheld 
computer.  The Palm Desktop application has the same applications found on 
the handheld device.  The MemoPad application is where the swipe transaction 
data is store.  Also installed with the Palm Desktop is a programmed called the 
Hotsync Manager whose icon looks like this  and will appear in the system 
task tray located in the bottom right corner of the PC screen when running.   It 
must be running (i.e. displayed in the system tray) to perform a Hotsync.   
 
The latest version of the Palm Desktop is version 4.0.1 for Windows and 4.0 for 
Mac.  Visit the Palm web site for a free copy at 
http://www.palm.com/us/support/downloads/visor/win_desktop_401.html or 
http://www.palm.com/us/support/downloads/visor/mac_desktop_40.html.  
The Palm web site is a good resource for the Palm Desktop and Hotsync 
manager -> http://www.palm.com/us/support/.  It has a very good trouble 
shooting section for Hotsync issues -> 
http://www.palm.com/us/support/hotsync.html . It is also advisable to read 
the ‘Advanced HotSync Operations’ chapter in the Handspring User Guide that 
is also on the Handspring CD.   BEFORE HOTSYNC ANY DATA, MAKE SURE THE 
HOTSYNC PROGRAM IS PROPERLY CONFIGURED AND ALL IMPORTANT DATA IS 
BACKED UP.   
 

Palm Desktop and Hotsync Manager Installation  

 
Insert the Green Handspring CD into the CD drive of the computer 
It should auto launch the following installation screen: 
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Read the installation screens and hit continue. 

 
After reading, hit Continue. 
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Hit Next  

 
Screen Shot after hitting Next (do NOT hit Cancel) 

 
Hit Next 
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If Microsoft Outlook is installed on the PC, the following dialog box will be 
display.  It is vital that Outlook is NOT selected at this point. 
Do NOT hit Next until ensuring the ‘I want to use Palm Desktop (PIM software included)’ 
is selected. 

 
 

Switch to ‘I want to use Palm Desktop.’  Selecting Outlook will install 
PocketMirror, which causes the swipe data stored in the MemoPad application 
to transfer to Outlook instead of the Palm Desktop.   
Once Palm Desktop is selected, hit Next 

 
Accept default destination folder and hit Next. 
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Select USB cradle and hit Next. 
 

 
Select Visor or Visor Deluxe and hit Next. 
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With Visor selected, hit Next. 
 

 

 
Enter a Hotsync User name, we suggest using a YYMMDD format 
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Suggest using a MMDDYY format for the Hotsync User name and if applicable 
append a single character when multiple devices present at one location.   
 
 
 

 
Screen Shots during install 
 

 
Screen Shots during install 
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Do not set up eMail – Not required – Click No. 
 

 
Screen Shot indicating HotSync Manager is starting 
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At this point, make sure you see the HotSync Icon in the bottom left corner of 
the screen (red/blue circular icon).   
Make sure the Hotsync Cradle or Cable is connected to the PC and the 
Handspring Visor.  Then Press the HotSync Button on the cradle  
 

 
Ensure Hotsync Manager Icon is visible in system tray – bottom right 
 
After pressing the Hotsync button, the Found New Hardware Wizard will appear 
on the PC screen and the screen of the Handheld will indicate it is trying to 
connect to the PC.  Ignore the handheld for now and continue with installing 
the software on the PC. 
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Select Yes, this time only, hit Next 
 

 
Press Next 
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Screen shot showing wizard searching CD for drivers 

 

 
Screen Shot showing wizard installing drivers from CD 
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Press Finish 
 
 

 
Found New Hardware message should appear after pressing Finish 
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Now that the drivers are installed, the computer is ready for the first Hotsync.  
The Handheld will probably have a screen stating  
“HotSync Problem”  - The connection between your handheld acomputer and 
the desktop could not be established.  Please check your setup and try again. 

 
Just hit the OK button on the Handheld to clear this message and then Press 
Hotsync Button on Cradle again, this time the Hotsync process should start and 
request a User name be selected. 
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Select the existing User name or create a new one. 

 
Using the existing User name, the Hotsync process should start and when 
complete, launch the product registration screen. 

 
Unclick the Product Registration button  
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Click Finish. 
 
 
Congratulations, you’ve installed the PalmDesktop / Hotsync manager and 
performed the first Hotsync! 
 
 
Step 2 - First HotSync Operation & Setting HotSync User Name 

Assuming the Palm Desktop software has been installed and that the HotSync 
manager is running (look for  Hotsync icon  in system tray located in bottom 
right of the screen), it is time to perform the first HotSync which will 
‘syncronize’ the data between the handheld and the Palm Desktop.  Place the 
handheld in the HotSync cradle or connect it to the PC with a HotSync cable 
and follow the directions on the next page.  If the HotSync window does not 
open on the Desktop computer: perform each of these steps in order.  After 
each step, try to synchronize.  If the HotSync operation succeeds, the problem 
is resolved and don’t try the next step. 

1. Is HotSync Manager on? Before you can synchronize, this software needs 
to be running. Turn it on if necessary by going to the Handspring folder 
and double clicking on it.  

2. Perform a soft reset on the Handheld: This is a great trick for solving a 
number of problems.  See the hardware reference guide for details. 

3. Disconnect your device from the HotSync cable or cradle, and connect it 
again. Don't press the HotSync button until the device is fully connected.  

4. Failure to communicate: Make sure that your desktop computer and 
handheld device are communicating properly.  
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5. Alarms pending? If any Calendar, To Do, SMS, MMS, voicemail, email or 
other alarms are awaiting a response from you, tap on "OK."  

6. HotSync configuration: Make sure you have the right cradle/cable, and 
your HotSync software is correctly configured. 

  

 

Hit the HotSync button on the 
cradle/cable and the following dialog 
box will display.  Since this is the first 
Hotsync, there should be no user 
names so hit the ‘New” button. Even if 
there are names already present, hit 
the New button.   

If an existing name is selected, then all 
the data associated with that name will 
be written to the handheld’s memory 
and all the license data will be saved in 
the selected user name which may 
already have other data.  So, hit the 
New button! 

 

 

Enter a New user name – use the date, 
e.g. 032204 instead of a name.  This 
will help track subsequent HotSyncs 
and provide a means to retrieve 
historical data.  

 

After creating the new name, select it 
for the user name list and hit OK.   
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After hitting OK, the Hotsync Progress 
box should display and confirm the 
Hotsync is taking place. 

 

 

Once Hotsync is complete, launch the Palm Desktop application, set the User 
name to the one just created (see user name pull down menu in top right 
corner) and click on the MemoPad icon on the left menu bar.   Shown below is 
what the Main screen of the Palm Desktop with the Memo Pad active should 
look like.  Check that the number of Memos matches the number of Memos in 
the Handheld.  On the left, the Memo is highlighted and on the right are its 
contents.  If there are no Memos and the HotSync operation worked, ensure 
that Pocket Mirror was NOT installed. If PocketMirror was installed, go to the 
add/remove programs, located PocketMirror and remove it.  Then reboot the 
computer to relaunch the Hotsync Manager.  

 
Main Screen of the Palm Desk Top showing the Memo Pad 

 
Exporting Data from Palm Desktop  

The Palm Desktop application allows all or selected Memos to be exported in 
several common formats including comma delimited, tab delimited format, and 
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text.  This document will use text since CardVisor puts field delimiters in the 
data (^ character) which the import wizard of Excel and Access can recognize.  
To start the process, first select the memos, which are to be exported.  It is 
possible to export all or just a subset of the memos to be exported by 
highlighting the desired memos.  Follow the directions below to export just the 
Memos which are categorized with the “CardVisor” Category. 
 
 
1.) Set the 
Category to 
“CardVisor”  
- See 
Category box 
circled in 
RED on 
right. 

  

 

 

 

2.) Place the mouse cursor in the middle of the ‘Description’ 
window and right click.  This will open a small menu, select the 
‘Select All’ menu item.  See RED circled on right. 

 

 

Then, from the main File 
menu, select the Export 
option.   

 
Palm Desktop –> File -> 
Export  

 

This will launch the Export As 
window that determines the 
file name, format and storage 
location.  
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Export As Window  

 

First select the file 
folder in the Export 
Window where the file 
should be saved.  Use 
the Pull Down arrow to 
change directories.   

Then Set the Export 
type as Text (*.txt) as 
the file Export type  

Then set the Range for 
‘Currently selected 
records’ 

 

 

 
 

Finally, enter a file name that contains the date(s) of the license 
captures.  This will help identify the file later 

Click on the Export button. 

 

Important: Make sure the file extension is “ .txt” and not “ .csv” since files with 
the “csv” file extension will not cause the Excel import wizard to launch.  If 
accidentally used, the csv file extension can be rename to txt by the file 
manager and no harm will be done. 
 
After hitting the Export button, the program will ask which field of the Memo 
Pad should be exported.  There are three fields in the Memo Pad application; 
Memo, Private and Category.  The Memo field contains the track data, the 
private field indicates whether the Palm OS should treat the record as private, 
and the last field is the category.  For this example, only the track data will be 
exported so just check the Memo items. 
 
 
Specify only the Memo Pad field for Export 
 

1.) Check the Memo item 
2.) Uncheck the Private and Category items 
3.) Hit the OK button 

 
 
 
After this window closes, the 
data will be exported and saved to the export file.  The Export 

complete message box should be displayed. 
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Deleting Data from Handheld 

Before deleting the data on the handheld, make sure it is completely 
transferred to the Palm Desktop and exported to a text file as described above.  
Open the exported file with a text editor such as Notepad (part of Windows) 
and examine the first and last line in the file to make sure they match the first 
and last memo in the handheld’s MemoPad application.  If complete, it is safe 
to delete the data in the Handheld.   To be absolutely sure, proceed to the 
import the data into Microsoft Excel step (next section) and then come back to 
deleting the data in the Handheld.   
 

There are two ways to delete the data from the Handheld.   One is to perform a 
Hard Reset on the handheld and the second is to use the Palm Desktop & 
Hotsync manager. 
 
Deleting Transaction Data via Hard Reset 
The most direct way to delete the old license data from the Handheld is to do a 
Hard Reset.   A Hard Reset,will erase all the license data on the handheld plus  
‘reboot’ the handheld, thus ensuring continued smooth operation.   A Hard 
Reset is like turning off & on your PC.  See Hard Reset directions in the 
Hardware User manual.  The basic steps are as follows.    
 

1. Remove CardTool reader 
2. Perform Hard Reset – see Hardware User Manual for details 
3. Tap on digitizer to center digitizer  (follow on screen prompts) 
4. Ensure Date/Time are correct when Prefs screen displays 
5. Re-insert CardTool reader – this will cause the welcome program to run 

and associate the Date Book button with the CardVisor application. Press 
Date Book key & Swipe a License to confirm proper operation. 

 
Next, put the handheld back in the 
HotSync cradle and hit the HotSync 
button.  When the ‘Select a user’ screen 
displays, hit the ‘New’ button and enter a 
name using a date format (e.g. MMDDYY 
or 083005).   If there are multiple 
handhelds being synchronized, the label 
them A, B, C, thru Z and append the same 
character to the HotSync name (e.g 
083005A or 083005B).  
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Do not pick an old/existing name as the 
Hotsync manager will then push the old 
transactions into the handheld.  Just enter 
the current date (e.g. 083005) when the 
‘New User’ form is displayed. 
  
 
By using this date format for the HotSync name, the transaction data for a 
specific time frame can be accessed by selecting the HotSync user name in the 
Palm Desktop (top right corner of the Main Palm Desktop screen).    
 

Deleting Data via Palm Desktop & HotSync Manager 
 

1. Open the Palm Desktop Application. 
2. Select the Hotsync User name for the PDA you'd like to delete the data 

from.  If you have multiple hotsync names for the same PDA, select the 
one used during the last Hotsync. 

3. Select the MemoPad icon (left side of screen).  You should see the 
Memos appear on the main screen. 

4. Go to the Edit Menu item, click on select - > All.  This will highlight ALL 
the Memos.  Or you can click on one Memo and which holding down the 
mouse key, drag down across the Memos you’d like to delete.  

5. Go to the Edit Menu and click on Delete or just hit the Del key on the 
keyboard. The following screen will appear. 

 
6. Assuming the data has already been exported to a text file, it is not really 

necessary to Archive deleted items at next HotSync, so uncheck this box.  
If the data was not exported to a text file, the leave it checked.  

7. Then perform another HotSync with the PDA having the same HotSync 
name as selected in step 2. 

8. This will erase the data on the PDA.  If the Archive deleted items at next 
HotSync was checked, then archive files(CardViso.MPA & RawData.MPA) 
will be created in the MemoPad directory for that Hotsync name.  See 
below. 
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These archive files may be opened by the Palm Desktop software and merged 
with an existing MemoPad transaction list.  See the Palm Desktop software user 
manual for details. 
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Importing MemoPad Data to Microsoft Excel 

The data exported from the Palm Desktop (see above) uses the carat character 
(^) to delimit each field.  Many 3rd party marketing firms prefer to receive 
contact data in Excel spreadsheet format.  Also to create mailing labels using 
the provided mailing label application note (see White CardVisor CD), it is 
necessary to import the data to Microsoft Excel.  For this example, Excel will be 
used because the mailing label application notes are based on it.  However, 
the import wizards for both Excel and Access are very similar.   
 
 

Click on the File -> Open 
menu item.  This will launch 
the Open Dialog box shown 
below.   

 

 
 
 
 

Select the directory which 
contains the exported 
memoPad data. 

Change the file type to Text 
Files (*.prn, *.txt, *cvs) 

Select the correct file (e.g. 
export.txt) or type the correct 
file name into the file name 
text box. 

Hit the open button. 
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After pushing the Open 
button the Excel import 
wizard will launch.  This 
Wizard determines how the 
data in the file will be 
interpreted when imported 
in the Excel spreadsheet.  

Select the Delimited radio 
button 

Start import at row 1 

File Origin Windows (ANSI) 

 

 
 
 
 
 
 
In the second step, the Wizard 
asks how the fields are to be 
delimited.  

 

Check the ‘Other’ delimiter 
option 

Uncheck the tab, space, 
semicolon, and comma 
options. 

Type the carat character ‘^’ into 
the ‘Other’ delimiter text box 

Hit the next button 

 

 
Note:  Once you enter the carat character into the text box, the 
Wizard will put vertical lines in the Data preview window. Make 
sure the lines are shown in the appropriate locations before 
proceeding. 
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The final step in the process is 
to indicate the format of the 
data in each column.   

 

Hit the Finish Button 

 

Note: For mailing labels, 
General is fine on all columns.  
If certain information should be 
treated differently, this screen 
allows it to be formatted 
appropriately. 

 

 
 

After hitting the finish button the data now has been imported 
into Excel. 

Shown here is what the 
imported data will look like in 
Excel.    

 

Note that the first name is in 
column A, the last name in 
column B, address in column 
C.  Also note each entry is in its 
own row and that in this 
example there are blank rows 
between each row of license 
data. 

 
 
To remove the empty 
rows in the data, just 
hit the sort button 

. 

Or select the Data -> 
Sort menu item to 
sort the entire 
spreadsheet.  

 

 
 
  

Here is the spreadsheet after the sort button has been pushed.   
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The final step in the 
process is to save the 
new Excel 
spreadsheet.  Select 
the File -> Save As 
menu item.  This will 
launch the Save As 
dialog window shown 
on the right.  Enter 
the desired file name 
and type.  In the 
example shown, the 
file type is Microsoft 
Excel Workbook 
(*.xls) and name is 
‘export.xls.’ 
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CardVisor III VIP & Banned Database - Creation and Usage 

Introduction 

CardVisor III has the ability to check if a driver’s license is on a list of approved 
and/or denied visitors.  This allows the operator to monitor who is showing up 
at the door and greet those on the list in an appropriate fashion.  The sections 
below will describe this feature in greater detail and demonstrate how to 
create, install, and maintain the VIP/Banned database. 
Database Conversion Utility Installation  

The files necessary to create the VIP/Banned database are in a zip file located 
in the CardVisor III directory on the White CardVisor CD.  Shown Below is the 
main directory of the CD followed by the CardVisor III directory. 

 
Root Directory of CardVisor CD 

 
CardVisor III Directory 

Copy either the db_conversion.zip or db_comversion.exe file to a directory on 
the PC’s harddisk and unzip them.  After unzipping the archives, a new 
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directory is created with 5 files shown below.  This new directory is the 
database conversion directory. 

 
Directory after unzipping db_conversion files 

Ban_VIP.pdb Palm OS database file which gets installed into 
handheld 

BAN_VIP_List.txt Contains the customer data – names/license #/ 
status 

CreateBanned_VIP_DB.bat Batch file that calls csv2pdb.exe using 
Ban_VIP_List.txt 

Csv2pdb.exe Creates Ban_VIP.pdb when called by batch file 
List_inf.txt File Descriptor – do not modify 
 
The ‘Ban_VIP_List.txt’ text file contains the raw data that is converted into the 
Ban_VIP.pdb Palm OS database.  Do not rename this file as the batch file looks 
for a file by this name when creating the Ban_VIP.pdb file.   This is the file 
which will be updated with your customer data.  
 
Description of Ban_VIP_List.txt format 

Each entry in the VIP/Banned list has four fields; the first name, the last name, 
the driver license number (if known) and the member status.   

Field 1  
(Required) 

Field 2 
(Reqcommeded) 

Field 3 
(Recommended) 

Field 4  
(Required) 

Last Name First Name Drivers License 
Number 

Status 

Text String Text String Alphanumeric Text 
String 

One digit Numeric String – 
Zero (0) for Banned, One (1) 
for VIP, etc.  (see chart below 
for other values) 
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Sample File provided on CD 

Shown above is the sample file provided on the CardVisor CD.  Notice some 
entries do not have a license number but that each line has 3 commas on it.  
The first name and driver license numbers are optional but recommended.   
 
How the VIP/Banned feature works 

After a card is swiped and the last name has been decoded, a last name 
search is performed in the VIP/Banned database. 
 
 
 
If there is a match on the last name, then the 
software will determine if the driver license numbers 
match.  If there is one or more last names that match 
and none that matches the license number, then the 
possible match screen will be displayed.  Only names 
without a license number will be displayed on the 
possible match list (those with license numbers are 
omitted).   
 
If the person scanned is actually on the list without a license number, then now 
is the time to append a note to the swipe data indicating their status.  Hit OK to 
clear the screen and use the append notes feature on the main screen to 
record the person’s status.  Once that data is transferred to a PC, their license 
number may be added to the existing VIP/Banned list. Alternatively, you can 
open the MemoPad application, scroll the appropriate memo and manually 
append a note to this person’s swipe data indicating their VIP or Banned 
status.  See the section titled Tip - Adding Notes to Swipe Data – Alternate to 
Append Note button  
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If there is an exact match on the last name and driver 
license number, the confirmed match list will be 
displayed.  Again the far right column will contain the 
status of the individual (Banned/VIP/bar staff/etc.)  
 

 

 

 

Status Codes 
Code Printed Message in Bold Code Printed Message inBold 

0 Banned – Not allowed  5 S.0.S. - Call a supervisor 

1 VIP – Very Important 
Person 

6 Member - Member in good standing 

2 CheckID - Check this 
ID in detail 

7 Owes $ - Owes Money (new code as of 
June 2005 release) 

3 911  - Call the Police 8 RFU -Reserved for Future Use 

4 BarStaf - Bar Staff 9 RFU -Reserved for Future Use 

Any other value results in an Unknown status message 

 

Notes & Limitations 
• The last name comparison is NOT case sensitive.  Capitalization does not 

matter in the database. 
• The software will display up to 6 people with the same last name on the 

possible match list.  The latest version of software allows scrolling 
through the VIP/Banned list by using the up/down arrows or scroll 
buttons once the possible match list is displayed. 

• Last names must NOT be hyphenated.   
 

How to Modify the Ban_VIP_List.txt file 

There are two approaches to modifying this text file.  The first is to use a simple 
text editor like NotePad or WordPad to open the file, manually insert a new 
entry at the correct alphabetical location or update an existing entry and save 
the changes.  Make sure to follow the constraints/requirements listed in the 
review section below.  It is important to follow these formatting constraints.  
This approach works well if only minor changes are required.  If the number of 
new names to be added is large or significant sorting is required, then it may 
be easier to use Microsoft Excel.    
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In the following images, the steps required to open, sort and save the 
Ban_VIP_List.txt list using Microsoft Excel are provided.  Note: These 
instructions were written using Microsoft Excel 2000.   
 
Start by launching Excel and opening the Ban_VIP_List.txt file. 
 
Open the ban_VIP_list with Microsoft 
Excel 

 

Since this is a text file, Excel should 
launch the import wizard that will guide 
the import process.  Note: Microsoft 
Access has a similar import wizard and 
these directions will work for Access with 
minor modifications. 

 

 

 
 
If the Text Import Wizard does not launch, then 
open the ban_VIP_List.txt after setting the ‘Files of 
type’ dialog box to ‘txt’. 

 

 

 

Select Delimited 
option in step one 
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Check Comma as 
the Delimiters 
and ‘none’ for text 
qualifier in the 
second step 
Notice vertical 
lines drawn where 
comma’s were 
located. 

 

 

 
 

 
 

  
 

 

Accept General 
data format for all 
columns in step 3 
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Shown is the Final 
result of Excel 
import wizard.  
 

Note: each field in 
its own column 
and no additional 
characters in each 
field. 

 

 
 

 
 
After Adding two new names (Zah and 
Waba) after Ali, the data is ready for 
sorting 
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Click square, which is to upper left of 
cell A1.  This will highlight entire 
worksheet 
Notice all cells are highlighted in 
blue/gray after clicking this square. 

 
 

 
 

 
 

Hit the Sort Ascending Button 
to sort by last name.   
Shown is the spreadsheet after 
sort.   
 

Notice Waba and Zah have 
been moved to bottom 

 

 
 

Select the File->Save As menu 
item and then select the ‘save 
as type’ to be CSV 

 
Note: Make sure it says *.csv 
in the save as type box 
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Hit Yes when this 
message appears 

 
 

Then exit Excel.   

 

Before existing, Excel will 
generate this message: 

Just hit no when this 
message is received.  The 
file was already saved. 

 

 

The directory should now 
look like this:  

 

Notice the original 
Ban_VIP_List.txt file 
and the new 
Ban_VIP_List.csv file. 

 

 
Directory after saving the new file in CSV format.   

 
 

The next step is to 
rename the 
Ban_VIP_List.txt file to 
something like 
Ban_VIP_List_old.txt and 
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then rename 
Ban_VIP_List.csv to 
Ban_VIP_List.txt.  After 
making these changes, 
the directory should look 
like this. 

 

The directory should now 
look like this: 

  
Directory after making name changes. 

 
 
Open the Ban_VIP_List.txt and the 
contents should look like this: 

 
Contents of Ban_VIP_List.txt after changes 

 
 
Reviewing the Ban_VIP_List.txt file 

Before running the conversion software, perform a final inspection of the data 
in the Ban_VIP_List.txt file.  Open the file with NotePad and review the points 
listed below. 
• Check to ensure the records are 

sorted, by last name, in ascending 
order from top to bottom.   

• Check to make sure there are 
commas between the columns and 
carriage returns at the end of each 
line (i.e. only four columns per line) 

• Make sure each line has at least a 
last name and either a 1 or a 0 in 
the status column.   

• Make sure there are no column  
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header titles 

•  Make sure there is only one 
carriage return at the end of the file. 

Ban_VIP_List.txt opened in Notepad 

  

 

Below is an example of an extra carriage return and correct number of carriage returns would 
look like.  

 

 
Extra Carriage Return 

 

 
Correct Number of Carriage Returns 

Example of an extra carriage return after the last record.  There should be only one carriage 
return as shown on the right.  Delete extra returns or conversion routine will not process the 
Ban_VIP_List.txt file 

 
 

Convert the Ban_VIP_LIST.txt file into a Ban_VIP.pdb Palm OS database file 

The next step is to run the conversion utility that creates the Palm Data Base 
(PDB) file.  This step uses a batch file to transform the Ban_VIP_List.txt into a 
Palm OS database file which has a *.PDB extension.  The batch file name is 
‘createBanned_VIP_DB.bat’.  This batch file calls csv2pdb.exe and uses a file 
called List_inf.txt to process the Ban_VIP_list.txt file into the output file.  Do not 
change or edit the list_inf.txt or batch file. 
 
To perform this step;  

1. First delete the Ban_VIP.pdb file in the directory.  This will ensure the old 
version is not used in the event the new one is not created.   

2. Then double click on the ‘createBanned_VIP_DB.bat’ file and a black 
DOS window (see below) should flash on the screen while the program 
executes.  On fast PCs and small files, it happens very quickly.  
Depending on the size of the database, this process can take anywhere 
from a few seconds to a couple minutes.   
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DOS window opened when the batch file is executing 

 
If there is a problem with the Ban_VIP_List.txt, an error message will be 
displayed on the screen.   The error message may not be displayed long on a 
fast machine.  If the Ban_VIP.pdb database is not created, then open a DOS 
window, change to the database conversion directory by using the 
ChangeDirectory command [CD], and run the createbanned_vip_db.bat file by 
typing ‘createbanned_vip_db.bat’ at the command prompt.  This will keep the 
window open long enough to read the error message.   If the conversion utility 
states there is an error on the number of fields, it is likely that there are extra 
carriage returns at the end of the Ban_VIP_List.txt file or missing commas on a 
line.  Make corrections to the Ban_VIP_List.txt and try again.  
 
Once completed, its time to Hotsync it into the Handspring Visor.  This will 
transfer the file to the handheld computer. 
 
HotSync the Ban_VIP.pdb Database 

This section assumes the Palm Desktop software has been installed on the PC.  
See the section titled Step 1 – Installing PC Software for installation details. 
 
To install the Ban_VIP.pdb file on the Handspring Visor – Just click on the 
Ban_VIP.pdb file and the following dialog box will be launched.  If it doesn’t, 
then launch the Palm Desktop application and use the install feature by either 

clicking on the install icon  or select View - > Install from the main menu. 
 
 Either should launch the Install Tool dialog box shown below. 
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Install Tool dialog box launched by clicking on Ban_VIP.pdb 

 
 

Once this dialog box displays, make sure the User name corresponds to the 
appropriate handheld.  Selecting the wrong User name sends the file to a 
different handheld during the Hotsync process.  After verifying the Hotsync User 
name,  hit Done.  The following dialog box will display after done is clicked. 
 

 
 

 
That’s it.  Next time the Handspring Visor is put in the cradle and the Hotsync 
button is pushed, the Ban_VIP.pdb file will be transferred into the Handspring 
Visor (assuming it has the same User name as selected above).   
 
Congratulation on loading your first Ban_VIP database!   
Now it is vital to test the file on the handheld to prevent fatal error messages 
on the handheld.  Do not skip this step! 
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Testing the Ban_VIP database in the HandHeld 

After loading a new database, its important to test it to make sure that it was 
properly installed and created.  Errors in the database will cause fatal error 
warnings so its important to resolve or remove the database from the 
handheld’s memory. 

 

Select the ‘Test VIP/Banned Database’ 
Menu Item 

 

 

The first line states the number of names 
in the database.  In this example there 
are 22 names. 

 

 

While testing, a ‘.’ Will print out on the 
screen for each record being tested.  If all 
pass, then a message similar to this will 
be displayed. 

 

 

If there is a problem, it is likely that the 
last names are not in the proper order.  
The software will stop testing the 
database as soon as it finds one name 
out of order.  If this error occurs, review 
the Ban_VIP_List.txt file, correct any 
errors and recreate & install the 
database.   
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If the database was not loaded, then the 
message shown to the right will be 
displayed. 

 

Errors in the Ban_VIP database will cause fatal errors messages or unresponsiveness.  Either 
correct and replace the Ban_VIP database or DELETE IT from the handheld’s memory.  Below is 
directions on deleting the database. 

   

From the main Applications 
screen, select the menu 
icon which displays a pull 
down menu. 

Select Delete on the pull 
down menu which displays 
a list of files for possible 
deletion. 

Select the Ban_VIP 
database and select Delete 
to delete it from memory. 

 

Database Trouble Shooting 

Problem Possible Problem Possible Solution 
Missing comma(s) between 
fields, extra commas in line or 
missing carriage return at end of 
each line. 

Check to make sure there are commas between the columns and carriage returns 
at the end of each line (i.e. only four columns per line) 

 

 

More than one or no carriage 
return after the last line in 
Ban_VIP_List.txt  file 

Make sure there is only one carriage return at the end of the file. 

Can not create 
VIP_Banned.pdb from 
Ban_VIP_List.txt file 

Data is incomplete Make sure each line has at least a last name and either a 1 or a 0 in the status 
column.   

While creating the 
VIP_Banned.pdb file, 
receiving the ‘error on 
the number of fields’ 

Extra carriage returns at the end 
of the Ban_VIP_List.txt file.   

Just delete extra carriage returns at the end of the Ban_VIP_List.txt file and try again. 

Database not in proper order Test database using  Test VIP/Banned Database’ Menu Item and if out of order, 
recreate and reinstall database. 

The driver’s license number for 
the person does not match the 
one in the database. 

Compare the driver’s license number captured for the license (open Memo in 
MemoPad).  If different with number stored in database, either remove number 
from database (this will cause them to be displayed on the possible match screen) 
or update their license number with the same number captured by CardVisor (this 
will cause them to be displayed on the confirmed match screen). 

Database not loaded. Test database using  Test VIP/Banned Database’ Menu Item and if out of order, 
recreate and reinstall database. 

Person not being 
found in database 

More than six people with same 
last name and no license 
numbers 

Enter the driver’s license number captured for this person (captured Memo in 
MemoPad) into the database.  This will cause them to be displayed on the 
Confirmed match screen. 
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 The Status field is not a ‘1’ or a 
‘0’ 

Review the status field for this person and ensure there is a ‘1’ or ‘0’ character in 
the field.  Any other character will cause the record to be ignored. 

Person has wrong 
status  

Status field not set correctly If the status field is 1, the person will be categorized as VIP, if it is any other value 
(e.g. 55 or 0), they will be categorized as BANNED.  Correct status field and reload 
database 

 

Encoded Stripe (Magnetic & Bar Code) – Formats & Reliability 

Formats 

The CardVisor ID scanner reads encoded information off the encoded 
(magnetic or 2D bar code) stripe of drivers license or ID card.  While most 
states have the same basic information on the encoded stripe, the locations 
and format differ.  From time to time, states will change how they encode the 
information on the stripe.  Additionally, since most do not read what they’ve 
encoded, they sometimes make mistakes that become part of the issued card 
population. This may cause difficulty in parsing the data.  When the software is 
unsure, it creates a memo in the MemoPad application that starts with the 
phrase “Trouble Parsing this data ->…” If you see a Memo like this, then please 
email it to support@tokenworks.com or email the entire MemoPad file 
(MemoPad.dat) and you will be one of the first to receive a software update 
that address this new license format.    
 
Reliability 

Driver licenses are exposed to varying conditions in a typical 4 to 6 year life 
cycle.  Unlike credit cards, Driver licenses are not frequently swiped nor are 
they typically replaced if the encoded stripe is damaged.  Therefore, read 
performance will vary with older licenses in typically poorer condition.    
 
For licenses with Magnetic stripes, it is possible to read just Track 2 of a 
license since it is encoded at a lower bit density than tracks 1 and 3, and less 
sensitive to damage.  Track 2 has the driver’s license number, date of birth and 
expiration date.  If the name does not appear on the screen, it is possible that 
Track 1 has become unreadable while track 2 is still readable.  Note: The 
software must be able to read track 2 information to display the age and card 
status. 
 
For licenses with 2D bar codes, make sure the bar code is not damage and 
that all foreign material is removed before reading.  The level of error 
correction incorporated into the bar code varies between states so some states 
will scan with quite a bit of damage while others will fail with minor damage.  
 
 

Document Information 
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 EVOLUTION OF THE DOCUMENT 
Version Date Author Evolution 

UM-110702-CC-R0 11/07/2002 CC Removed CardVisor III material from CardVisor Manual to 
create CardVisor I & II manual and this document  

UM-110702-CC-R1 12/19/02 CC RawData Category, Button Preferences, Hard Reset, Trouble 
shooting chart, Exporting data from Palm Desktop  

UM-110702-CC-R2 1/20/03 CC Adding notes to swipe data (e.g. Banned/VIP indicator, phone, 
email info), Graffiti table.  

UM-110702-CC-R3 3/21/04 CC Updates for new VIP/Banned categories (CV III feature), 
Append Note Feature (CV III feature) and non-duplicate 
subsequent swipe feature.    

UM-110702-CC-R4 8/21/05 CC Enhanced data download/deletion section, Added PIN code 
protection section, Added Anti Pass Back section (CV IV 
feature), corrected field ordering in VIP/Banned section, 
enhanced VIP/Banned database testing section and db-
conversion files installation. 

    

    

    

    

 
 

Limited Warranty - CardTool® reader and/or CardVisor® software 

TokenWorks™ Inc. (hereafter “TokenWorks”) warrants the TokenWorks 
CardTool® reader, the CardVisor® software, and this Manual, hereafter jointly or 
individually the “product” IN ITS ENTIRETY, to be in good working order for a 
period of 90 days from the date of purchase. Should this product fail to be in 
good working order at any time during this warranty period, TokenWorks will, at 
its option, repair or replace this product at no additional charge except as set 
forth below. Repair parts and replacement products will be furnished on an 
exchange basis and will be either reconditioned or new. All replaced parts and 
products become the property of TokenWorks. This limited warranty does not 
include service to repair damage to the product resulting from accident, 
disaster, misuse, abuse, or modification of the product performed without the 
prior written approval of TokenWorks. 
 
Limited Warranty service may be obtained by sending the product during the 
warranty period to TokenWorks. Before sending material, please obtain a 
Return Material Authorization (RMA) number by requesting one from 
TokenWorks.  To obtain additional return and contact information, visit 
www.tokenworks.com.  If this product is to be returned you agree: (a) to insure 
the product or assume the risk of loss or damage in transit; (b) to prepay 
shipping charges to the warranty service location, and (c) to use the original 
shipping container or equivalent. 
 
ALL EXPRESS AND IMPLIED WARRANTIES FOR THIS PRODUCT, INCLUDING THE 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR PARTICULAR USE, ARE 
LIMITED IN DURATION TO A PERIOD OF 90 DAYS FROM THE DATE OF 
PURCHASE, AND NO WARRANTIES, WHETHER EXPRESS OR IMPLIED, SHALL 
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CONTINUE BEYOND SUCH PERIOD. EACH PURCHASER UNDERSTANDS THAT 
THE TOKENWORKS PRODUCT IS OFFERED AS IS. TOKENWORKS AND ITS 
SUPPLIERS ASSUME NO RESPONSIBILITY FOR ANY DAMAGE OR LOSS CAUSED 
BY DELETION OF DATA AS A RESULT OF MALFUNCTION, DEAD BATTERY, OR 
REPAIRS.  BE SURE TO MAKE BACKUP COPIES OF ALL IMPORTANT DATA ON 
OTHER MEDIA TO PROTECT AGAINST DATA LOSS.  
IF THIS PRODUCT IS NOT IN GOOD WORKING ORDER AS WARRANTED ABOVE, 
YOUR SOLE REMEDY SHALL BE REPAIR OR REPLACEMENT AS PROVIDED 
ABOVE. IN NO EVENT WILL TOKENWORKS BE LIABLE TO YOU FOR ANY 
DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS OR OTHER 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF OR 
INABILITY TO USE SUCH PRODUCT OR FOR ANY CLAIM BY ANY OTHER PARTY, 
IRRESPECTIVE OF ANY NOTICE TO TOKENWORKS OF THE POSSIBILITY OF 
SUCH DAMAGES OR CLAIM. THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS. YOU MAY ALSO HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO 
STATE. 
 
Age Verification Calculation Limitations 

The CardVisor application is warranted to read the date of birth information 
encoded on the machine-readable (magnetic or 2D bar code) stripe and display 
the current age based on current date/time information contained in the 
handheld computers real time clock (RTC).  It will also read other information 
on the stripe and present it to the operator. It should be understood that the 
displayed age may differ from the actual age of the person presenting the card 
for any one of a number of reasons. Among the most likely are: 
 

• the card does not belong to the person presenting it, 
• the encoded machine-readable stripe has been altered,  
• the date of birth presented to the issuing authority was misrepresented, 
• the issuing authority mis-encoded the date of birth on the card, 
• the handheld computer real time clock is not set to the current 

date/time. 
The above list of reasons is not exhaustive. 
 
State and Local Privacy Laws, Ordinances or Rules 

Some states and local government units regulate who, how and what 
information from a driver’s license can be electronically viewed or recorded.  
Check with the authorities in your jurisdiction before using the CardVisor 
product.  Purchaser is wholly responsible for insuring full compliance with the 
laws of the jurisdiction wherein the product is to be used.  TokenWorks fully 
disclaims any liability for any loss, damages or untoward circumstances that 
may arise from the inappropriate use of the product or of the data retrieved 
through its use. 
  
End of Document. 


